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Updating “Using Autodesk Inventor” to Release 5

Appendix R5–3
Assembly Modeling

Chapter 3 introduces the principles of assembly modeling. You construct assemblies of
solid parts, exploded presentations of the assemblies, and bill of materials for the
assembly. This appendix complements Chapter 3 by delineating the following features in
Autodesk Inventor 5:

⇒ Place Constraint Dialog box

⇒ Snap ‘n Go

⇒ Composite iMate

⇒ Transitional Surface Constraint

⇒ Assembly Pattern

⇒ Assembly Work Features

⇒ Work Feature Visibility

⇒ Measurement

⇒ Shared Content Link

⇒ Capture Camera in Presentation

Place Constraint Dialog Box
In R5, the Place Constraint dialog box has three tabs that enable you to place three kinds of constraints in an
assembly — Assembly constraints, motion constraints, and transitional constraint. Using assembly
constraints, you remove degrees of freedom between two selected components of an assembly and position
them relative to each other. All together, there are five kinds of assembly constraints — Mate, flush,
tangent, angle, and insert. To stipulate intended motion between components, you use motion constraints.
To constrain a set of contiguous faces and a cylindrical face, you use transitional constraint. Figure 3–1
shows the Place Constraint dialog box.
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Figure 3–1
Place Constraint dialog box

Snap ‘N Go
Apart from using the Place Constraint dialog box, you can use snap and go facility (Snap N’ Go) to apply
assembly constraint by holding down the Alt key, selecting a feature of a component, dragging the
component to its mating component, and releasing the mouse button. After the component part is dragged to
its mating component, you will hear an audio note indicating that the components are in a constrained
position.

Basically, the selected geometry type determines the kind of constraint to be applied to the component.
During the course of applying assembly constraint by using snap and go facility, you can change the kind of
constraint by releasing the Alt key after you selected a feature of a component and entering a shortcut key.
The table below summaries the ways how snap and go constraints are applied.

Holding down the Alt
key and selecting a
planar face, linear
edge, or axis

Apply a
mate or
flush
constraint

Releasing the Alt key
after dragging the
selected component and
pressing the Space Bar

Toggle between mate
and flush constraint

Holding down the Alt
key and selecting a
cylindrical face

Apply a
tangent
constraint

Releasing the Alt key
after dragging the
selected component and
pressing the Space Bar

Toggle between tangent
constraint inside or
outside the selected
cylindrical face

Holding down the Alt
key and selecting a
circular edge

Apply an
insert
constraint

Releasing the Alt key
after dragging the
selected component and
pressing the Space Bar

Change the direction of
the insert constraint

The table below lists the shortcut keys and the constraints corresponding to the shortcut keys.

Shortcut key Action

M or 1 Changes to a mate constraint

A or 2 Changes to an angle constraint

T or 3 Changes to a tangent constraint

I or 4 Changes to an insert constraint

R or 5 Changes to a rotation motion constraint
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S or 6 Changes to a translation constraint

X or 8 Changes to a transitional constraint

To learn the snap ‘n go utility, you will perform the following steps to construct an assembly.

1. Start a new part file. Use metric template.
2. With reference to Figure 3–2, construct a sketch.
3. Set the display to an isometric view and extrude the sketch a distance of 100

mm. (See Figure 3–3.)
4. With reference to Figure 3–4, construct a sketch.

Figure 3–2
Sketch

Figure 3–3
Sketch being extruded



70 Updating “Using Autodesk Inventor” to Release 5

Figure 3–4
Sketch constructed on a face of the base solid

5. Extrude the second sketch to cut through the solid. (See Figure 3–5.)
6. Rotate the display and construct another sketch in accordance with Figure 3–6.
7. Refer to Figure 3–7, place a through hole with a diameter of 10 mm.

A component for the cam set assembly is complete. Save and close your file. (File name: Base.ipt)

Figure 3–5
Sketch being extruded to cut through the solid
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Figure 3–6
Sketch constructed on a face of the solid

Figure 3–7
Hole feature being placed

Now you will construct the cam of the cam set assembly.

1. Start a new part file. Use metric template.
2. With reference to Figure 3–8, construct a sketch.
3. Set the display to an isometric view and extrude the sketch a distance of 10

mm. (See Figure 3–9.)
4. Construct a sketch in accordance with Figure 3–10.
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Figure 3–8
Sketch

Figure 3–9
Sketch being extruded

Figure 3–10
Sketch constructed on a face of the solid part

5. Extrude the sketch a distance of 15 mm to join the base solid part. (See Figure
3–11.)

6. With reference to Figure 3–12, construct a sketch.
7. Extrude the sketch a distance of 5 mm to cut the solid part. (See Figure 3–13.)

The cam is complete. Save and close your file. (File name: Cam.ipt)
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Figure 3–11
Sketch being extruded

Figure 3–12
Sketch constructed

Figure 3–13
Sketch being extruded

Now you will construct the follower of the cam set assembly.

1. Start a new part file. Use metric template.
2. With reference to Figure 3–14, construct a sketch.
3. Extrude the sketch a distance of 10 mm. (See Figure 3–15.)

The component part is complete. Save and close your file. (File name: Follower.ipt)
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Figure 3–14
Sketch constructed

Figure 3–15
Sketch being extruded

Now you will use snap and go utility to assembly the component parts together.

1. Start a new assembly file. Use metric template.
2. Place the components (base, cam, and follower) in the assembly one by one.

Then rotate the display. (See Figure 3–16.)
3. Hold down the Alt key and select the circular edge of the cam indicated in

Figure 3–17. (Note the insert constraint symbol.)
4. Release the Alt key and drag the component to the circular edge of the base

indicated in Figure 3–18.
Upon releasing the mouse button, you will hear an audio note confirming that assembly constraint is
applied. Now an insert constraint is applied.
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Figure 3–16
Components placed in the assembly

Figure 3–17
Display rotated, Alt key held down, and circular edge selected

Figure 3–18
Selected component dragged to its final assembled position
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5. With reference to Figure 3–19, rotate the display.
6. Hold down the Alt key and select the edge indicated in Figure 3–19.
7. Release the Alt key and drag the mouse.
8. Press the A key to change to angle constraint.
9. With reference to Figure 3–20, drag the mouse cursor to an edge.
10. Release the mouse button.

An angle constraint is placed. Save and close your file. (File name: CamSet.iam)

Figure 3–19
Edge selected

Figure 3–20
Changed to angle constraint and dragged to an edge

Composite iMate
Very often, the same kinds of assembly constraints are applied to a component when it is placed in any
assembly. For example, bolts are used repeatedly in assemblies and are always constrained in the same way
by using the insert constraint. To save time in assembling this kind of components, you predefine a
constraint in the component to specify how it is to be constrained in an assembly. In essence, the predefined
constraint is half of a constraint pair in an assembly. This half of a constraint pair is called an iMate. To
construct an iMate, you use the Create iMate tool from the Standard toolbar. In R5, you can combine a
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number of iMate constraints in a component together to form a composite iMate constraint. To provide
clues to valid locations of iMate components, a visual and audio feedback is provided.

Now you will construct iMate constraints and combine them into a single composite iMate.

1. Open the file Follower.ipt.
2. Select Create iMate from the Standard toolbar.
3. In the Create iMate dialog box, select the Mate button.
4. Select the face indicated in Figure 3–21 and select the Apply button.

Figure 3–21
iMate being applied

5. With reference to Figure 3–22, select the face and select the OK button.
Two iMate constraints are constructed. Now you will combine them into a single composite iMate.

6. Select the + sign of the iMate icon from the Browser to expand it.
7. Hold down the Control key and select the iMate icons.
8. Right-click and select Create Composite. (See Figure 3–23.)

A composite iMate is constructed. Save and close your file.
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Figure 3–22
Second iMate being applied

Figure 3–23
Composite iMate constructed

Now you will construct a composite iMate for the base of the cam set assembly.

1. Open the file Base.ipt.
2. With reference to Figure 3–24, construct two iMate constraints. Because it is

essential that the sequence of iMate constraints in one composite iMate must
match the sequence of iMate constraints in another composite iMate, here you
should apply iMate to the horizontal face first and then to the vertical face.

3. Combine the iMate constraints into a single composite iMate. (See Figure 3–
25.)

Figure 3–24
iMate constraints constructed
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Figure 3–25
Composite iMate being constructed

Now you will use snap ‘n go utility to assemble the cam follower and the cam base.

1. Open the file CamSet.iam.
2. Hold down the Alt key, select the iMate symbol of the follower, and drag it to

the iMate symbol of the base component. (See Figure 3–26.)
3. Release the mouse button.

The follower is assembled to the base. (See Figure 3–27.)

Figure 3–26
Composite iMate selected
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Figure 3–27
Follower assembled

Transitional Surface Constraint
To specify intended relationship between a cylindrical face and a set of contiguous faces, you use a
transitional constraint. A transitional constraint keeps the constrained faces in contact as you translate a
component along the open degrees of freedom. It is particularly useful in simulating motion between a cam
and a follower.

Now you will apply transitional surface constraint to assemble the follower to the cam. (Note that you can
also use snap ‘n go utility to apply transitional constraints.)

4. Select Place Constraint from the Assembly toolbar or panel.
5. Select the Transitional tab from the Place Constraint dialog box.
6. With reference to Figure 3–28, select the cylindrical face of the follower.
7. Select the face indicated in Figure 3–29.

Transitional constraint is applied. To appreciate how transitional constraint works in this assembly, perform
the following steps:

8. Select the Angle constraint from the Browser, right-click, and select Drive
Constraint.

9. In the Drive Constraint dialog box, set the End Angle to 360 and select the
Forward button. (See Figure 3–30.)

Now save and close your file.

Figure 3–28
Moving face selected
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Figure 3–29
Transitional face selected

Figure 3–30
Constraint being driven

Assembly Pattern
To place multiple instances of a component in an assembly, you construct assembly pattern. Using the
Assembly Pattern dialog box, you place circular patterns, rectangular patterns, and associative patterns. In
R5, you can suppress individual elements of an assembly pattern. Moreover, you can separate an element
from the assembly pattern while remaining in place in the assembly. As a result, you can retain a copy of the
original source instance of the pattern if you delete the assembly pattern.

Now you will construct an assembly pattern and then manipulate the elements in the pattern.

1. Start a new assembly file. Use metric template.
2. Select Create Component from the Assembly toolbar or panel.
3. In the Create In-Place Component dialog box, specify a file name

(PatternBase.ipt), select a file location, and select the OK button.
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4. With reference to Figure 3–31, construct a sketch.
5. Set the display to an isometric view and extrude the sketch a distance of 10

mm. (See Figure 3–32.)

Figure 3–31
Sketch constructed in a component part of an assembly

Figure 3–32
Sketch being extruded

6. Construct a new sketch in accordance with Figure 3–33.
7. Extrude the sketch to cut through the solid part. (See Figure 3–34.)
8. With reference to Figure 3–35, construct a rectangular pattern.
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Figure 3–33
Sketch constructed on a face of the solid part

Figure 3–34
Sketch being extruded to cut through the solid part

Figure 3–35
Rectangular pattern being constructed
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The pattern base is complete. Now you will construct an instance component part.

9. Select the assembly from the browser and double-click.
10. Select Create Component from the Assembly toolbar or panel.
11. Specify a new part name (Instance.ipt) and select the OK button.
12. With reference to Figure 3–36 construct a sketch.
13. Revolve the sketch to construct a revolved solid. (See Figure 3–37.)

The instance part is complete.

Figure 3–36
Sketch constructed in the second component part of the assembly

Figure 3–37
Sketch being revolved

Now you will assemble the components.

14. Select the assemble from the browser and double-click.
15. Hold down the Alt key and select the edge of the instance part indicated in

Figure 3–38 to start apply an insert constraint.
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16. Release the Alt key and drag the component to the circular edge of the pattern
base indicated in Figure 3–39.

17. Release the mouse button.
The instance part is inserted into the pattern base.

Figure 3–38
Edge selected

Figure 3–39
Component part dragged

18. Select Pattern Component from the Assembly toolbar or panel.
19. Select instance part and then the feature pattern. (See Figure 3–40.)
20. Select the OK button.

An associative assembly pattern is constructed. Save the assembly (Pattern.iam) and the part files.

Now you will manipulate the elements of the associative assembly pattern.

21. With reference to Figure 3–41, select an element of the assembly pattern from
the browser, right-click, and select Suppress.
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Figure 3–40
Assembly pattern placed

Figure 3–41
Element of an associative assembly pattern being suppressed

An element of the associative assembly pattern is suppressed.

22. With reference to Figure 3–42, select an element of the assembly pattern from
the browser, right-click, and select Independent.

An element of the assembly pattern is made independent of the pattern.

23. With reference to Figure 3–43, select the assembly pattern from the browser,
right-click, and select Delete.

The assembly pattern is deleted and the independent element is retained. (See Figure 3–44.)  Close your
file. (Do not save.)
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Figure 3–42
Element of an associative assembly pattern being made independent

Figure 3–43
Assembly pattern being deleted

Figure 3–44
Assembly pattern deleted
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Assembly Work Features
In R5, you can construct assembly work features to help locate components and establish sketch plane for
making new parts in an assembly, Now you will construct an assembly of components and construct work
features in the assembly to facilitate assembly of components.

1. Start a new part file. Use metric template.
2. With reference to Figure 3–45, construct a sketch.
3. Extrude the sketch a distance of 15 mm. (See Figure 3–46.)
4. With reference to Figure 3–47, construct a work plane passing through three

vertices of the solid part.

Figure 3–45
Sketch constructed

Figure 3–46
Sketch being extruded
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Figure 3–47
Work plane constructed

5. Split the solid part. (See Figure 3–48.)
Save and close your file. (Work.ipt)

Figure 3–48
Solid part being split

Now you will construct a work plane in an assembly.

6. Start a new assembly file. Use metric template.
7. Place the component part (Work.ipt) in the assembly.
8. Select Work Plane from the Assembly toolbar or panel.
9. Select the face indicated in Figure 3–49 and drag the cursor to construct a

work place offset to the selected face.
10. In the Offset dialog box, type 20.

A work plane is constructed.

11. Place another instance of the component (Work.ipt) in the assembly. (See
Figure 3–50.)

12. Hold down the Alt key and select a face indicated in Figure 3–50.
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Figure 3–49
Work plane being constructed

Figure 3–50
Component placed and mate constraint being applied

13. Release the Alt key and drag the component to the work plane indicated in
Figure 3–51.

14. Release the mouse button.
A mate constraint is placed.
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Figure 3–51
Component dragged to the work plane

To appreciate how the work plane helps in locating the components in an assembly, perform the following
steps:

15. Select the plus sign of the work plane from the browser to expand it.
16. Double-click Flush.
17. In the Edit Constraint dialog box, change the offset distance to 30 mm and

select the OK button. (See Figure 3–52.)
The assembly is complete. Save your file. (File name: Work.iam)

Figure 3–52
Work plane being edited
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Work Feature Visibility
You can override the visibility of work features of all the components in an assembly globally. To change
the visibility of work features in an assembly, perform the following steps:

18. Select Work Geometry from the View pull-down menu.
19. Uncheck the User Work Planes button.

The work planes are turned off. (See Figure 3–53.)

Figure 3–53
Work plane turned off

Measurement
In R5, the measurement tools are available both in part file and assembly tool. You can measure distance,
angle, loop, and area. To access the measurement tools, select the Tools pull-down menu. (See Figure 3–
54.)

Using the Measure Distance tools, you measure length of a line, length of an arc, distance between points,
radius and diameter of a circle, or position of elements relative to the active coordinate system.

Using the Measure Angle tool, you measure the angle between two lines, edges, or points.

Using the Measure Loop tool, you measure the length of closed loops defined by face boundaries, or other
geometry.

Using the Measure Area tool, you measure the area of enclosed regions.



Appendix R5–3  Assembly Modeling          93

Figure 3–54
Measurement tools

Shared Content Link
In R5, you can set the URL for third-part content added to an assembly. Now you will perform the
following steps:

1. Open an assembly file.
2. Select Tools>Application Options.
3. In the Options dialog box, select the Assembly tab.
4. In the Assembly tab, specify the shared content link. (See Figure 3–55.)
5. Select the OK button.
6. Select Insert>Shared Content.

The shared content link is inserted.
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Figure 3–55
Assembly tab of the Options dialog box

Capture Camera
In R5, you can translate the position of the capture camera in AVI file recordings from one location to
another. Now you will perform the following steps.

1. Start a new presentation file.
2. Select Create View from the Presentation panel or toolbar.
3. Select an assembly file from the Select Assembly dialog box and select the OK

button. (See Figure 3–56.)
4. Referring to Figure 3–57, tweak the components apart.
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Figure 3–56
Selecting an assembly file to place in the presentation file

Figure 3–57
Components tweaked apart

5. Select Animate from the Presentation panel or toolbar. (See Figure 3–58.)
6. In the Animation dialog box, select the Record button.
7. Specify an AVI file.
8. In the Video Compression dialog box, select the OK button.
9. Select the Play Forward button from the Animate dialog box.
10. While recording, select the Rotate button from the Standards toolbar to

reposition the capture camera.
An AVI file of the animated tweaking of the assembly is constructed. Save and close your file.
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Figure 3–58
Animating the tweaked presentation


